
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

        

 

 

 

 

 

 

 

 

 

 

 

 

 

       ความรู้พื้นฐานก่อนใช้งาน 

      Adobe   Dreamweaver CS5 

เอกสารประกอบการสอน  

รายวิชา การสร้าง Webpage ด้วย Web Editor (ง23256)  

เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 
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 เอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 ชุดนี้ ได้จัดท าข้ึนเพ่ือ 
ใช้เป็นส่วนหนึ่งในการเรียนรู้ของผู้เรียน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี สาระการเรียนรู้เพ่ิมเติม 
รายวิชา การสร้าง Webpage ด้วย Web Editor รหัสวิชา ง23256 ชั้นมัธยมศึกษาปีที่ 3 โดยเน้นผู้เรียนเป็น
ส าคัญให้สามารถพัฒนาความรู้ ความเข้าใจเกี่ยวกับเรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 ทั้งนี้ 
ได้ขยายผลในด้านเนื้อหาให้กว้างและชัดเจนมากยิ่งขึ้น ซึ่งผู้เรียนสามารถน าไปประยุกต์ใช้ในชีวิตประจ าวัน และใช้ใน
อนาคตได้ เอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 ชุดนี้มีทั้งหมด 6 เล่ม 
ในแต่ละเล่มมีความต่อเนื่องของความรู้ ดังนั้น ผู้เรียนจึงควรศึกษาตามข้ันตอนทีละชุดไม่ควรข้าม เพราะอาจท าให้
เกิดความไม่เข้าใจในเนื้อหา 
 เอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 เล่มที่ 1 ความรู้พื้นฐาน
ก่อนใช้งาน  Adobe  Dreamweaver CS5 ผู้เรียนควรอ่านค าแนะน าการใช้ให้เข้าใจก่อนเป็นล าดับแรก และ
ปฏิบัติตามด้วยความซื่อสัตย์ต่อตนเอง เพื่อผลที่ดีในการสร้างองค์ความรู้ที่ยั่งยืนแก่ตัวผู้เรียน 
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เอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 ได้ด าเนินการจัดท า 

ทั้งหมด 6 เล่ม ประกอบด้วย 
 เล่มที่ 1 ความรู้พื้นฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 
 เล่มที่ 2 การสร้างข้อความหรูหรา รูปภาพตระการตาหน้าเว็บเพจ 
 เล่มที่ 3 จัดระเบียบเว็บเพจ  ด้วยขอบเขตของตาราง 
 เล่มที่ 4 สร้าง Link เพ่ือเชื่อมโยง ก าหนดเค้าโครงด้วย Frame  
 เล่มที่ 5 สร้างฟอร์มกรอกข้อมูล   แทรกความสมบูรณ์ ด้วย Multimedia  สร้างไอเดีย Interactive 
 เล่มที่ 6 เว็บเพจเก๋ไก๋ ด้วย spry สไตล์ 
 เอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 กลุ่มสาระการเรียนรู้ 
การงานอาชีพและเทคโนโลยี สาระการเรียนรู้เพ่ิมเติม รายวิชา การสร้าง Webpage ด้วย Web Editor  
รหัสวิชา ง23256 ชั้นมัธยมศึกษาปีที่ 3 จ านวน 6 เล่ม เป็นเอกสารประกอบการสอนที่มีการจัดกิจกรรมการเรียนรู้
ที่นักเรียนได้รับประสบการณ์จากการเรียนรู้โดยตรง เป็นเรื่องที่เกี่ยวข้องกับการสร้างงานกราฟิก นักเรียนสามารถ
เรียนรู้ด้วยความสนุกสนาน ได้รับความรู้และความเพลิดเพลิน โดยยึดหลักผู้เรียนเป็นศูนย์กลาง ตลอดจน
สอดคล้องกับหลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน พุทธศักราช 2551 นักเรียนสามารถน าความรู้และทักษะ 
ในการอ่านที่ได้จากการท ากิจกรรมการเรียนรู้ ไปประยุกต์ใช้ในชีวิตประจ าวัน และการศึกษาหาความรู้ต่อไป 
ในอนาคต 
 
 
 
  

ค าชี้แจงเอกสารประกอบการสอน 
เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 
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เอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 เล่มที่ 1 ความรู้พื้นฐาน
ก่อนใช้งาน  Adobe  Dreamweaver CS5 เล่มนี้ ใช้ประกอบการจัดกิจกรรมการเรียนการสอนนักเรียน 
ชั้นมัธยมศึกษาปีที่ 3 โรงเรียนศรีรัตนวิทยา  โดยมีขั้นตอนการจัดกิจกรรมการเรียนการสอน ดังนี้ 
 1.ครูแจกเอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 เล่มที่ 1  
ความรู้พื้นฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 ให้นักเรียน 
 2. ครูชี้แจงการใช้เอกสารประกอบการสอน ให้นักเรียนทราบก่อนลงท าการเรียนการสอนและลงมือปฏิบัติ 
 3. ครูให้นักเรียนท าแบบทดสอบก่อนเรียนเพ่ือดูว่านักเรียนมีพ้ืนฐานความรู้ ความเข้าใจเกี่ยวกับ 
เรื่องท่ีเรียนมากน้อยเพียงใด 
 4. ครูให้นักเรียนศึกษา เอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 
เล่มที่ 1 ความรู้พื้นฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 พร้อมท ากิจกรรมการเรียนรู้ที่ 1และ 2 เพ่ือให้
นักเรียนได้ทบทวนและเกิดความรู้ความเข้าใจอย่างถูกต้อง 
 5. ครูให้นักเรียนท าแบบทดสอบหลังเรียนเพื่อดูว่านักเรียนมีความรู้ ความเข้าใจหลังเรียนมากน้อยเพียงใด 
 6. ครูสังเกตพฤติกรรมคุณลักษณะที่พึงประสงค์ และบันทึกผล 
 7. ครูตรวจคะแนนและบันทึกผลลงในแบบเก็บคะแนน ในการท าเอกสารประกอบการสอน เรื่อง การใช้
โปรแกรม Adobe Dreamweaver CS5 เล่มที่ 1ความรู้พ้ืนฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 เล่มนี้ 
 8. ครูแจ้งคะแนนให้นักเรียนทราบและชมเชยนักเรียนพร้อมให้ค าแนะน าเพ่ิมเติม 
 
 
 
  

ค าชี้แจงส าหรับครู 
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เอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 เล่มที่ 1  
ความรู้พื้นฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 เล่มนี้ ใช้ประกอบการจัดกิจกรรมการเรียนการสอน 
นักเรียนชั้นมัธยมศึกษาปีที่ 3 โรงเรียนศรีรัตนวิทยา โดยมีขั้นตอนการจัดกิจกรรมการเรียนรู้ ดังนี้ 
 1. นักเรียนฟังค าชี้แจงการใช้เอกสารประกอบการสอนให้เข้าใจ 
 2. ให้นักเรียนรับเอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 เล่มที่ 1 
ความรู้พื้นฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 
 3. นักเรียนเริ่มท าแบบทดสอบก่อนเรียนเพ่ือประเมินดูว่านักเรียนมีพ้ืนฐานความรู้ความเข้าใจมากน้อย
เพียงใด 
 4. ให้นักเรียนศึกษาเนื้อหาท าความเข้าใจให้ดีตั้งแต่หน้าแรกถึงหน้าสุดท้ายตามล าดับอย่าข้ามขั้นตอนและ
ท าแบบฝึกหัดท้ายเล่มเอกสารประกอบการสอน เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5 เล่มที่ 1 
ความรู้พื้นฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 
 5. เมื่อพบค าชี้แจงหรือค าถามในแต่ละเล่มของเอกสารประกอบการสอน ให้นักเรียนอ่านและท ากิจกรรม
ที่ก าหนดให้อย่างรอบคอบ 
 6. ส่งผลงานการท ากิจกรรมการเรียนรู้จากท้ายเล่มเอกสารประกอบการสอนเพื่อให้ครูตรวจและบันทึกผล 
 7. เมื่อท าแบบฝึกหัดเสร็จแล้วจัดเก็บอุปกรณ์ให้เรียบร้อย 
 8. เมื่อนักเรียนทุกคนท ากิจกรรมการเรียนรู้ครบแล้วให้นักเรียนท าแบบทดสอบหลังเรียนด้วยความตั้งใจ
และซื่อสัตย์ 
 9. รับฟังการบอกคะแนน ค าชมเชย และค าแนะน าเพิ่มเติมจากครู 
 
 
  

ค าชี้แจงส าหรับนักเรียน 
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สาระส าคัญ 
 

 
 

ครูต้องช้ีแจงให้นักเรียนทราบถึงบทบาทของนักเรียน ดังต่อไปนี้ 
 1. นักเรียนต้องอ่านค าสั่งและปฏิบัติตามข้ันตอนอย่างระมัดระวัง 
 2. นักเรียนต้องพยามยามท ากิจกรรมต่าง ๆ จนสุดความสามารถ 
 3. หลังจากปฏิบัติกิจกรรมแล้ว นักเรียนจะต้องจัดเก็บอุปกรณ์ทุกชิ้นเข้าที่ให้เรียบร้อย 
 4. เนื่องจากมีเวลาจ ากัด นักเรียนต้องตั้งใจท ากิจกรรมให้เสร็จอย่างรวดเร็ว 

 
 

  
 1. ใช้เทคโนโลยีสารสนเทศน าเสนองานในรูปแบบที่เหมาะสมกับลักษณะงาน ง 3.1 ม.3/3 
 2. ใช้คอมพิวเตอร์ช่วยสร้างชิ้นงานจากจินตนาการหรืองานที่ท าในชีวิตประจ าวันตามหลักการท าโครงงาน
อย่างมีจิตส านึกและความรับผิดชอบ ง 3.1 ม.3/4 

 
 
 

 1. เป้าหมายการเรียนรู้ (จุดประสงค์) 
 1.1 ด้านความรู้ ความเข้าใจ (K) 
  1) รู้จักและเข้าใจความรู้พื้นฐานก่อนใช้งานโปรแกรม Adobe Dreamweaver CS5 
  2) รู้จักและเข้าใจขั้นตอนการพัฒนา หลักการออกแบบ รูปแบบการจัดโครงสร้างของเว็บไซต์ และ
รูปแบบของหน้าเว็บเพจได้ 
 1.2 ด้านทักษะ / กระบวนการ (P) 
  1) อธิบายความรู้พ้ืนฐานก่อนใช้งานโปรแกรม Adobe Dreamweaver CS5 ได ้
  2) อธิบายขั้นตอนการพัฒนา หลักการออกแบบ รูปแบบการจัดโครงสร้างของเว็บไซต์ และรูปแบบ
ของหน้าเว็บเพจได้ 
 1.3 ด้านคุณลักษณะอันพึงประสงค์ (A) 
  1) มีวินัย 
  2) ใฝ่เรียนรู้ 
  3) มุ่งม่ันในการท างาน 

 
 

 ความรู้พื้นฐานก่อนใช้งาน Adobe Dreamweaver CS5 การสร้างเว็บเพจ รู้จัก Adobe Dreamweaver 
การเรียกใช้โปรแกรม  Adobe  Dreamweaver CS5 การเรียกใช้ค าสั่งของโปรแกรม  การยกเลิกค าสั่งและ 
การท าซ้ า การออกจากโปรแกรม  ส่วนประกอบของโปรแกรม   องค์ประกอบของหน้าเว็บเพจ การสร้างเว็บไซต์
การสร้างหน้าเว็บเพจใหม่ การบันทึกไฟล์เว็บเพจที่สร้าง และการเปิดดูหน้าเว็บที่สร้างบนบราวเซอร์ 

บทบาทนักเรียน 

ตัวช้ีวัดชั้นปี 

จุดประสงค์การเรียนรู้ 
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แบบทดสอบก่อนเรียน 
เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5  

เล่มท่ี 1 ความรู้พื้นฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 

 
 
 
 

 
ค าชี้แจง  ให้นักเรียนเลือกค าตอบที่ถูกที่สุดเพียงค าตอบเดียวและท าเครื่องหมายกากบาท ( X )  
   ลงในกระดาษค าตอบ เวลา 10 นาที คะแนน 15 คะแนน 
 
ข้อ 1 WWW ย่อมาจากค าใดต่อไปนี้ 
 ก. Word While Web  ข. World Wide Web 
 ค. World Wi Web  ง. Word Why Web 

ข้อ 2 ภาษาทางคอมพิวเตอร์ที่พัฒนาขึ้นใหม่ ในการใช้ Adobe Dreamweaver เรียกว่า ภาษาใดต่อไปนี้ 
 ก. HTML    ข. Visual basic 
 ค. Java    ง. PHP 

ข้อ 3 ข้อมูลจากทุกมุมโลกทีถู่กโยงใยไปมาถึงกันได้ราวกับสิ่งใด 
  ก. เส้นขนมสายไหม  ข. ลูกโลก 
   ค. ใยแมงมุม   ง. สายรุ้ง 

ข้อ 4 ข้อใดไม่ใชส่่วนประกอบใน WWW 
   ก. Home Page   ข. Web Site 
  ค. Web face   ง. Web Browser 

ข้อ 5 ข้อใดมกีารเรียกใช้โปรแกรม  Adobe  Dreamweaver  CS5 ได้ถูกต้อง 
 ก. Start      Accessories         Adobe Dreamweaver CS5   
 ข. Start      ACD system         Adobe Dreamweaver CS5 
   ค. Start      Control Panel      Adobe Dreamweaver CS5    
        ง. Start      All Programs         Adobe Dreamweaver CS5  

ข้อ 6 โปรแกรม Adobe Dreamweaver มีส่วนประกอบหลัก ๆ ดังต่อไปนี้ ยกเว้นข้อใด 
 ก. เมนูบาร์ (Menu bar)     ข. ชาเนล (Chanel) 
 ค. แท็บเครื่องมือ   ง. แถบสถานะ (Status bar) 

ข้อ 7 เนื้อความ , รูปภาพ และเสียง องค์ประกอบเหล่านี้ เราเรียกว่าอะไร  
 ก. Object   ข. Catalog 
 ค. Text    ง.  File 
 
ข้อ 8 ในก าหนดเว็บไซต์ใหม่ใน Dreamweaver มีก่ีวิธี 
 ก. 1 วิธ ี    ข. 2 วิธ ี 
 ค. 3 วิธ ี    ง. 4 วิธ ี  
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ข้อ 9 ข้อใดกล่าวเกี่ยวกับหน้าที่ Page from Sample ได้ถูกต้อง 
 ก.  สร้างหน้าเว็บโดยใช้ต้นแบบ ข. สร้างหน้าเทมเพลต เพ่ือใช้เป็นต้นแบบในการสร้างหน้าเว็บ 
 ค. สร้างหน้าเว็บแบบอื่นๆ  ง. สร้างหน้าเว็บจากต้นแบบที่ Dreamweaver มีให้ 

ข้อ 10 หมวด Headings ท าหน้าที่เก่ียวกับสิ่งใด 
 ก. ก าหนดแสดงลิงค์บนหน้าเว็บ ข. ก าหนดหน้าตาของส่วนประกอบต่างๆ บนหน้าเว็บ 
 ค. ก าหนดคุณสมบัติหัวของเว็บเพจ ง. ก าหนดชื่อให้ส่วนหัวเรื่องของเว็บเพจ 
 

ข้อ 11 ในการใส่ข้อความบนหน้าเว็บคล้ายกับการพิมพ์เอกสารในโปรแกรมใด  
 ก. โปรแกรม Word  ข. โปรแกรม Excel 
 ค. โปรแกรม paint  ง. โปรแกรม bookmark 

ข้อ 12 หากต้องการเปิดดูหน้าเว็บที่สร้างไว้บนบราวเซอร์ด้วยวิธีลัด โดยกดปุ่มใด 
 ก. F1 
 ข. F2 
 ค. F10 
 ง. F12 

ข้อ 13 หน้าต่างการท างานใน Dreamweaver สารมารถเลือกมุมมองการท างานได้กี่รูปแบบ  
 ก. 2 รูปแบบ   ข. 3 รูปแบบ 
 ค. 4 รูปแบบ   ง.  5 รูปแบบ 

ข้อ 14 แท็บ Layout เป็นแท็บที่ท าหน้าที่เกี่ยวกับสิ่งใด 
 ก. รวบรวมเครื่องมือที่ใช้ในการสร้างแบบฟอร์มสอบถาม     
 ข. รวบรวมเครื่องมือที่ช่วยในการจัดองค์ประกอบบนหน้าเวบ็ 
 ค. รวบรวมเครื่องมือส าหรับสร้างแอพพลิเคชั่นติดต่อกับฐานข้อมูล     
 ง. รวบรวมเครื่องมือที่ช่วยให้การสร้างฟอร์มได้รวดเร็วขึ้น 

ข้อ 15 ข้อใดเป็นแท็บที่รวบรวมเครื่องมือส าหรับวาง และปรับแต่งตัวอักษรบนหน้าเว็บ 
 ก. Layout 
 ข. Text 
 ค. Spry 
 ง. Data 
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ข้อ ก ข ค ง ข้อ ก ข ค ง 
1     11     
2     12     
3     13     
4     14     
5     15     
6          
7          
8          
9          
10          

กระดาษค าตอบ 
แบบทดสอบก่อนเรียน 
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เวิลด์ไวด์เว็บ (World Wide Web หรือ  WWW ) หรือที่เรียกกันสั้นๆ ว่า เว็บ (Web) เป็นบริการ
ข้อมูลข่าวสารในแบบสื่อประสมหรือมัลติมีเดีย (Multimedia) กล่าวคือ ข้อมูลเหล่านี้จะเป็นข้อมูลที่มีทั้งข้อความ
, ภาพ และเสียงประกอบกัน แทนที่จะมีเพียงตัวอักษรละลานตาเพียงอย่างเดียว จึงสามารถเรียกร้องความสนใจ
จากผู้ชมได้เป็นอย่างดี ความก้าวหน้าของเทคโนโลยีปัจจุบัน ท าให้ข้อมูลประเภทนี้สามารถแสดงภาพเคลื่อนไหว
ในแบบของภาพยนตร์ และแสดงเสียงได้คุณภาพระดับเดียวกับแผ่นซีดีเลยทีเดียว 
 ข้อมูลนี้จะถูกแบ่งเป็นหน้า ๆ แต่ละหน้าจะถูกเขียนขึ้นด้วยภาษาทางคอมพิวเตอร์ที่พัฒนาขึ้นใหม่ 
เรียกว่า ภาษา HTML (Hyper Text Markup Language) ซึ่งสามารถเชื่อมโยงถึงกันได้โดยไม่จ าเป็นต้องอยู่ 
ที่เดียวกัน ดังนั้น ข้อมูลจากทุกมุมโลกจึงถูกโยงใยไปมาถึงกันได้ราวกับใยแมงมุม จึงเรียกว่า  เวิลด์ไวด์เว็บ   หรือ  
เครือข่ายใยแมงมุม 
 
 
 

     Home Page  
 เว็บเพจหน้าแรกสุดของข้อมูลแต่ละเรื่อง ซึ่งก็เปรียบเสมือนหน้าปกของหนังสือนั่นเอง ส่วนของโฮมเพจนี้
จะเป็นส่วนที่บอกให้ทราบว่าข้อมูลนี้เป็นข้อมูลเรื่องใด พร้อมกับมีสารบัญในการเลือกไปยังหัวข้อต่างๆ ในเรื่อง
นั้นๆ ด้วย 

     Web Site 
 เป็นเครื่องมือที่ใช้ในการจัดเก็บเว็บเพจแต่ละองค์กรที่จะน าเสนอข้อมูลของตนในรูปของเว็บนี้มักจะมี
เว็บไซต์เป็นของตนเอง และมักใช้ชื่อองค์กรเป็นชื่อเว็บไซต์เพ่ือให้ผู้สนใจสามารถจดจ าได้ง่าย 

    Web Page  
 เอกสารข้อมูลในแต่ละหน้าซึ่งถูกเขียนขึ้นด้วยภาษา HTML ข้อมูลที่แสดงในเว็บเพจแต่ละหน้านี้ 
อาจประกอบด้วยข้อความ , ภาพ และเสียง จึงเป็นข้อมูลแบบสื่อประสม หรือ มัลติมีเดีย 
 

ความรู้พื้นฐานก่อนใช้งาน Adobe Dreamweaver CS5 
 

ส่วนประกอบใน WWW (World Wide Web) 
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        เว็บบราวเซอร์ (Web Browser) 
    เว็บเพจแต่ละหน้าเป็นเอกสารข้อมูลที่ถูกเขียนขึ้นด้วยภาษา HTML ดังนั้น การที่เครื่องของเราจะอ่าน
และแสดงผลเว็บเพจเหล่านี้ได้  จะต้องมีโปรแกรมพิเศษส าหรับท าหน้าที่นี้โดยเฉพาะ โปรแกรมเหล่านี้ เรียกว่า   
เว็บบราวเซอร์ (Web Browser)   ซึ่งมีอยู่มากมายในปัจจุบัน แต่ที่รู้จักกันดีเห็นจะได้แก่ Internet Explorer 
ของบริษัทไมโครซอฟท์  Google Chrome โดยมี Google เป็นผู้พัฒนา  และ Mozilla Firefox โดยมีทีม 
Mozilla เป็นผู้พัฒนา ซ่ึงเป็น (Open source browser) ที่สามารถให้โปรแกรมเมอร์ทั่วโลกพัฒนาโปรแกรมเสริม
เพ่ือใช้ร่วมกับ Mozilla Firefox ได้อีกด้วย ปัจจุบันเป็นที่นิยมของผู้ใช้งาน Internet เป็นอย่างมาก ความนิยม 
ของผู้ใช้ทั่วโลกใกล้เคียงกันกับ Google Chrome เพราะมีความปลอดภัยสูง การเปิดหน้าเว็บเพจท าได้อย่าง
รวดเร็ว มีโปรแกรมเสริม  
 

 

 

 

   
 การสร้างเว็บเพจ จะกระท าได้ 2 ทางด้วยกัน คือ 

1.    สร้างข้ึนเอง โดยการเรียนรู้ค าสั่งของภาษา HTML แล้วพิมพ์เข้าไปผ่านทางโปรแกรม Text 
Editor ใดๆ เช่น Notepad โดยตรง 

2.   ใช้โปรแกรมส าหรับสร้างเว็บ โดยใช้โปรแกรมต่าง ๆ ที่มีความสามารถในการสร้างเว็บเพจ  
ซึ่งมีอยู่มากมายหลายโปรแกรมด้วยกัน การสร้างเว็บเพจด้วยวิธีนี้ เราไม่จ าเป็นต้องเรียนรู้ค าสั่งของภาษา HTML 
แต่อย่างใด โปรแกรมเหล่านี้จะท าการแปลงให้เราเองโดยอัตโนมัติ  ปัจจุบันมีโปรแกรมท่ีก าลังได้รับความนิยม  
Adobe Dreamweaver CS5,  Adobe Dreamweaver UltraDev , Adobe HomeSite  , Microsoft 
FrontPages 
 

          ภาษา HTML 
  HTML (Hypertext Markup Language) เป็นภาษาที่ใช้ในการเขียนโปรแกรมภาษาหนึ่งของ
คอมพิวเตอร์ เพ่ือตอบสนองในการแสดงผลบนจอภาพในระบบอินเตอร์เน็ต (Internet) ในลักษณะของเว็บเพจ 
ซึ่งสามารถแสดงผลได้ทั้งภาษาไทยและภาษาอังกฤษ รวมทั้งรูปทรงกราฟฟิค, ภาพนิ่ง, ภาพเคลื่อนไหว, เสียง หรือ
แม้กระท่ังการเชื่อมโยงไปยังเว็บไซต์อ่ืนๆ ในระบบอินเตอร์เน็ต 
 ภาษา HTML เป็นภาษาท่ีมีลักษณะเป็น โค้ด (Code) กล่าวคือ จะเป็นไฟล์ที่เก็บข้อมูลที่เป็นตัวอักษร 
ในมาตรฐานของ  รหัสแอสกี (ASCII Code) โดยเขียนอยู่ในรูปของเอกสารข้อความ (Text Document)   
ดังนั้นจึงท าให้ง่ายต่อการเรียนรู้ สามารถก าหนดรูปแบบและโครงสร้างได้ง่ายด้วยภาษา HTML   นี้ได้ถูกพัฒนา
ตั้งแต่รุ่น 1.0 , 2.0 , 3.0 จนถงึรุ่น 4.0 ในปัจจุบัน นอกจากนี้  ภาษา HTML ยังมีลักษณะพิเศษที่ควรทราบดังนี้ 

การสร้างเว็บเพจ 
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สามารถใช้ได้กับโปรแกรมสร้างและแก้ไขไฟล์ข้อความ (Text Editor) ได้แก่ Notepad, Word 
Processing ต่างๆ ซึ่งง่ายต่อการเรียนรู้ และไฟล์ที่ได้จะมีขนาดเล็ก 

HTML ที่ถูกบันทึกใน Text Editor จะมีชนิดของไฟล์เป็น HTM ส าหรับในระบบปฏิบัติการ MS-DOS 
และจะมีชนิดเป็น HTM หรือ HTML ในระบบปฏิบัติการยูนิกซ์ , วินโดวส์ 

สามารถท างานได้บนเว็บบราวเซอร์ทุกตัวที่สนับสนุน HTML ได้แก่ Netscape รุ่นต่างๆ Microsoft 
Internet Explorer , American Online , Mosaic เป็นต้น 

 
  โครงสร้างของภาษา HTML 

 การสร้างเอกสาร HTML มีองค์ประกอบหลักอยู่  2  ส่วน คือ ส่วนที่เป็นข้อความที่จะพิมพ์ และส่วนที่
เป็นค าสั่ง ส าหรับส่วนที่เป็นค าสั่งที่จะน ามาใช้เพ่ือเปลี่ยนแปลงรูปร่างและแบบของตัวอักษรหรือเอกสารใด ๆ 
(Attribute) จะถูกเรียกว่า แท็ก (Tag)  และจะเขียนไว้อยู่ในเครื่องหมาย < > ในรูปแบบ <แท็ก> เช่น    
<HTML>, <B> ,<U>   เป็นต้น โดยแต่ละแท็กจะท าหน้าที่แตกต่างกันไป แบ่งออกเป็น   2   กลุ่ม ดังนี้ 

1.   รูปแบบค าสั่งที่มีเพียงค าสั่งเดียวหรือมีแท็กเดียว สามารถใช้งานได้เลยและสิ้นสุดความหมายด้วยตัว
มันเอง เช่น <BR> , <WBR> เป็นต้น 

2.   รูปแบบค าสั่งที่แยกออกเป็น 2 ส่วน หรือแท็กคู่ คือ มีส่วนเริ่มต้นและส่วนจบของค าสั่ง โดยที่ส่วนจบ
ของรูปแบบค าสั่งจะมีเครื่องหมาย Slash ( / ) ก ากับไว้หน้าแท็กนั้น ๆ  
ตัวอย่างเช่น 
  <HTML>………</HTML> 
  <B>……………</B> 
  <U>……………</U>  เป็นต้น 

 ในการเขียนรูปแบบค าสั่งที่แยกออกเป็น 2 ส่วน หรือแท็กคู่ ค าสั่งนั้นจะต้องเป็นค าสั่งที่สมมาตรกัน เช่น 
เมื่อเปิดด้วยค าสั่ง  ตัวหนา <B> และขีดเส้นใต้ <U> เวลาปิดค าสั่งก็ต้องเปิดด้วยขีดเส้นใต้ก่อนแล้วจึงปิดด้วย
ค าสั่งตัวหนา ดังนี้ 

              <B><U> ........ขอ้ความที่ต้องการ....... </U ></B > 
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    ค าสั่งในการก าหนดโครงสร้างหลัก 
  รูปแบบการจัดวางต่อไปนี้เป็นรูปแบบมาตรฐาน ประกอบไปด้วยค าสั่งหลักอยู่ 4 ค าสั่ง โดยมีลักษณะการจัด

วางและรายละเอียดดังนี้ 
 <HTML> 
 <HEAD> 
 <TITLE> 
   ข้อความที่ต้องการน าแสดงผลบนแถบชื่อเรื่อง (Title bar) 
  </TITLE>   
   </HEAD> 

   </BODY> 
              ข้อความและค าสั่งใด ๆ ที่ต้องการปรับแต่งหน้าเว็บเพจ 
 
  </BODY> 

</HTML> 

 ค าสั่งหลัก   <HTML> .........</HTML>   เป็นค าสั่งที่ท าหน้าที่บอกจุดเริ่มต้นและจุดจบของเอกสาร 
HTML  

 ค าสั่งหลัก <HEAD> …… </HEAD> เป็นค าสั่งที่ท าหน้าที่ก าหนดส่วนหัวเรื่อง โดยจะประกอบด้วยค าสั่ง
หลัก  <TITLE> …… </TITLE> ซึ่งเป็นค าสั่งที่ใช้ก าหนดข้อความที่ต้องการน ามาแสดงผลบนแถบชื่อ
เรื่อง (Title bar) โดยก าหนดความยาวของข้อความได้ไม่เกิน 64 ตัวอักษร 

 ค าสั่งหลัก <BODY> …… </BODY>  เป็นค าสั่งที่ท าหน้าที่ก าหนดข้อความ และรูปแบบค าสั่งใดๆ ที่
ต้องการปรับแต่งเอกสารบนส่วนของจอภาพ และจะแสดงผลบนจอภาพเมื่อถูกเรียกใช้จากเว็บบราวเซอร์ 

 
 
 
 
 
 

  Adobe Dreamweaver CS5 เป็นโปรแกรมส าเร็จรูปที่ใช้ส าหรับการพัฒนาเว็บไซต์ โดยมีคุณสมบัติ 
ในการออกแบบและสร้างเว็บเพจ จนถึงการพัฒนาแอพลิเคชั่นเบิ้องต้น ซึ่งในโปรแกรมตัวนี้มีเครื่องมือส าหรับการ
วางข้อความ ภาพกราฟิก ตาราง แบบฟอร์ม พร้อมทั้งมัลติมีเดียต่าง ๆ เพื่อแสดงให้ผู้พัฒนาเว็บไซต์ใช้งานได้ง่าย 
โดยไม่ต้องรู้จักภาษา HTML, JavaScript, CSS หรือภาษาสคริปต์อื่น ๆ ซึ่งเมื่อออกแบบและพัฒนาเว็บไซต์ใน
โปรแกรม แล้วน ามาแสดงผลทางบราวเซอร์ก็จะเห็นเป็นลักษณะที่ได้จัดวางไว้ หรือจะเรียกอีกอย่างว่า What 
You See Is What You Get (WYSIWYG) จึงเหมาะสมกับผู้ที่เริ่มต้นและผู้ใช้งานทั่วไปจะน ามาพัฒนาเว็บไซต์ 

คุณสมบัติในใหม่ Adobe Dreamweaver CS5 
         - สามารถสร้างเว็บไซต์ได้อย่างง่าย คือ ช่วยให้ขั้นตอนของการสร้างเว็บไซต์ท าได้ง่ายขึ้นกว่าเดิม 
         - สามารถตรวจสอบโค้ด CSS อย่างรวดเร็ว โดยใช้วิธีการตรวจสอบจากมุมมอง Inspect ท าให้ 

สามารถตรวจสอบโค้ด CSS ได้และสามารถแก้ไขทางพาเนลของ CSS Style ได้ทันที 
         - ยกเลิกคุณสมบัติของ CSS ได้ทันทีโดยไม่ต้องอ่านโค้ด 

รู้จัก Adobe Dreamweaver 
CS5
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         - สามารถท างานกับ Adobe BrowserLab ซึ่งเป็นเครื่องมืออยู่ใน CS Live ที่ท าหน้าที่ให้บริการ
ออนไลน์ Web service โดยสามารถเลือกเว็บบราวเซอร์ที่ต้องการแสดงผลได้เลย ทั้งยังช่วยในการตรวจสอบ 
ความถูกต้องและความเข้ากันได้กับเว็บบราวเซอร์อีกด้วย 

         - สนับสนุนการสร้างเว็บไซต์ด้วย HTML 5.0 ซึ่งจะมีผลต่อการสร้าง SEO ในอนาคตอีกด้วยและ
ยังมีการปรับปรุงโค้ดต่างๆ ให้คอมพิวเตอร์สามารถแยกแยะเนื้อหาในเว็บเพจได้เข้าใจมากยิ่งขึ้น 

         - มีตัวช่วยสร้างค าสั่งภาษา PHP จะแสดงในรูปแบบของฟังก์ชั่นต่างๆ ขึ้นมาให้เลือกใช้ โดยไม่ต้อง
พิมพ์ค าสั่งเอง ซึ่งจะเป็นผลดีคือได้ค าสั่งที่ถูกต้องไม่ผิดพลาดในเวลาแสดงผล 

         - สนับสนุนการท างานร่วมกับ Adobe Business Catalyst ซึ่งเป็นแอพลิเคชั่นบนเซิร์ฟเวอร์  
ท าหน้าที่เป็นแพลตฟอร์มกลางของนักออกแบบเว็บเพจ ช่วยให้สร้างเว็บเพจออนไลน์ได้ดียิ่งขึ้น 

         - รองรับการท างานของ CMS(Content Management System) ซึ่งจะช่วยในการจัดเนื้อหา
เหมือนการจัดการใน Wordpress Joomla และ Drupal 

  
 คุณสมบัติท่ีถูกยกเลิกในเวอร์ชั่นก่อน  
   - การตรวจสอบการท างานของ JavaScript ในบราวเซอร์ 

- การสร้าง Web Photo Album 
- การแทรก Navigation bar 
- การใช้งาน Behavior บางตัว (Show/Hide Pop-up Menu, Show Event For, 

Play Sound.Timeline, Control Shockwave or SWF, Check Browser) 
 

 

       1.  การเรียกใช้โปรแกรม  Adobe  Dreamweaver  CS5 สามารถเรียกใช้ได้  2  วิธี  ดังนี้   
วิธีที่  1   เรียกจากปุ่ม  Start   
           1)  คลิกเมาส์ที่ปุ่ม Start 
           2)  เลื่อนเมาส์ไปที่ Programs  
               หรือ All Programs   
               คลิกเมาส์ที่ชื่อ    
              Adobe Dreamweaver CS5  
              จะเข้าสู่  โปรแกรมได้ทันที  
 
 
 
 
 
 
 
 

 

Adobe Dreamweaver CS5 
 

การเรียกใช้โปรแกรม  Adobe  Dreamweaver CS5



 
 

13 
 

 

 

วิธีที่  2  เรียกจากไอคอนบนเดสก์ทอป  
1.  ดับเบ้ิลคลิกเมาส์ท่ีไอคอนโปรแกรม                   บนเดสก์ทอปจะเข้าสู่โปรแกรมได้ทันที 
2.  เมื่อเปิดโปรแกรมแล้วจะแสดงหน้าต่างที่เรียกว่า  Start page ที่มีตัวเลือก ดังนี้ 

    1) Open a Recent Item  เป็นการเปิดไฟล์งานที่เคยใช้งานแล้ว โดยจะมีรายชื่อไฟล์งานแสดงอยู่
เรียงล าดับจากที่เปิดใช้งานล่าสุดเป็นต้นไป หรือจะเลือกไฟล์อื่นที่ 
Open ก็ได้ 

 2) Create New เป็นการสร้างไฟล์งานใหม่ โดยปกติแล้วในส่วนนี้จะเลือกท่ี HTML  
  ซึ่งเป็นการสร้างเว็บเพจพื้นฐาน แต่ถ้าเลือกหัวข้ออ่ืน หน้าเว็บเพจนั้น 
  ก็จะเป็นไฟล์ตามชนิดที่เลือกใช้งาน เช่น ไฟล์งาน PHP, ASP และ 

JavaScript เป็นต้น 
 3) Top Features (videos) เป็นส่วนที่ใช้ส าหรับเข้าไปดูรายละเอียดและเทคนิคต่างๆ ของการ 
  ใช้งานโปรแกรมผ่านทางเว็บไซต์ของ Adobe 
 4) เป็นส่วนของการเปิดดูค าแนะน าในการใช้งานโปรแกรม 
 5) เป็นส่วนส าหรับดาวน์โหลดโปรแกรมหรือดูข้อมูลบนเว็บไซต์ของ Adobe 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

1 2 3 

4 5 
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1 

2 

ซ่ึงในที่นี่ เราจะคลิกเลือกเป็น  เพ่ือสร้างหน้าเอกสาร  HTML ขึ้นมาใหม่ จากนั้นจะเข้าสู่
หน้าจอเริ่มต้นของโปรแกรม Dreamweaver 

 
 

 
 
 
 
 

 
 
 
 
 
 
 

  
  การเรียกใช้ค าสั่งในโปรแกรมท าได้  2  วิธี  ดังนี้ 
 

 
 แถบเมนู (Menu bar) เป็นส่วนที่แสดงค าสั่งที่ถูกจัดไว้เป็นกลุ่มๆ เรียกว่า เมนู เพ่ือความสะดวก 
ในการเรียกใช้ค าสั่งในแต่ละเมนูจะกระท าได้ดังนี้ 

1.  คลิกท่ีชื่อเมนู    
 2.  คลิกท่ีชื่อค าสั่ง  
 
    
 
 

 
 
 
 

การเรียกใช้ค าสั่งจากแถบเมนู 
 

การเรียกใช้ค าสั่งของโปรแกรม   



 
 

15 
 

 

วางเมาส ์
แล้วคลิก

ขวา 

 
เมนูลัด (Context Menu) จะเป็นค าสั่งพิเศษท่ีโปรแกรมจัดเตรียมไว้ให้ โดยค าสั่งเหล่านี้ 

จะเปลี่ยนไปตามงานที่เราท าขณะนั้นการเรียกใช้เมนูลัดจะกระท าได้โดยน าเมาส์วางบนหน้าต่างเอกสาร  
คลิกปุ่มขวาของเมาส์  

 

 

 

 

 

 

 

     
 เลือกค าสั่ง  Edit  >  Undo และ 
 เลือกค าสั่ง  Edit  >  Redo 
 
 
 

    
 
การออกจากโปรแกรม  Dreamweaver  CS5   สามารถท าได้  3  วิธี ดังนี้   

  วิธีที่  1  เลือกเมนูค าสั่ง   File   เลือกค าสั่ง  Exit  ดังรูป 
 

 

การเรียกใช้ค าสั่งจากเมนูลัด (Context 
menu)  

การยกเลิกค าสั่งและการท าซ้ า 

การออกจากโปรแกรม   
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1 2 3 

4 

5 6 

  วิธีที่  2  คลิกท่ีปุ่ม    ของหน้าต่างโปรแกรม ดังรูป 

 
  วิธีที่  3  คลิกท่ีไอคอน              Adobe Dreamweaver CS5   ที่มุมบนซ้ายของหน้าต่างโปรแกรม 
แล้วเลือกค าสั่ง   Close  ดังรูป 

 

 
 

 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 

 ส่วนประกอบของโปรแกรม   Dreamweaver CS5 
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คลิกเลือกแท็บเครื่องมือ 

ซึ่งโปรแกรม Adobe Dreamweaver มีส่วนประกอบหลัก ๆ ดังนี้ 
1. เมนูบาร์ (Menu bar)  
2. แท็บเครื่องมือ 
3. หน้าต่างการท างาน (Document Window)  
4. แถบสถานะ (Status bar) 
5. Properties Inspector  
6. พาเนล (Panel)  

 
 1.  เมนูบาร์ (Menu bar) เป็นส่วนที่ใช้ในการสร้างและท างานกับโปรแกรม ซึ่งมีการแบ่งเป็นกลุ่มค าสั่ง
ต่าง ๆ เป็นหมวดหมู่และเก็บไว้เป็นเมนู โดยในแต่ละเมนูก็จะมีเมนูย่อยๆ ไว้เรียกใช้งานตามต้องการ 
 

 
 

2. แท็บเครื่องมือ เป็นเครื่องมือที่ใช้ส าหรับสร้างองค์ประกอบต่างๆ (เราเรียกองค์ประกอบเหล่านี้ 
ว่าออบเจ็ค) ที่จะน ามาสร้างหน้าเว็บเพจ โดยกลุ่มเครื่องมือจะถูกเก็บไว้เป็นกลุ่มในแท็บต่างๆ 7 แท็บ ดังนี้ 
 

 
 
 
 
 
 

แท็บ Common: เป็นแท็บที่รวบรวมเครื่องมือต่างๆที่เราเรียกใช้งานบ่อย ได้แก่ การแทรกภาพ  
การแทรกตาราง เป็นต้น 

 
 

 แท็บ Layout: เป็นแท็บที่รวบรวมเครื่องมือที่ช่วยในการจัดองค์ประกอบบนหน้าเว็บ 
 

 
 

แท็บ Forms: เป็นแท็บที่รวบรวมเครื่องมือที่ใช้ในการสร้างแบบฟอร์มสอบถาม และตัวเลือกต่างๆ 
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แท็บ Data: เป็นแท็บที่รวบรวมเครื่องมือส าหรับสร้างแอพพลิเคชั่นติดต่อกับฐานข้อมูล 
 

 
 

 แท็บ Spry:  เป็นแท็บที่รวบรวมเครื่องมือที่ช่วยให้การสร้างฟอร์มได้รวดเร็วขึ้น 
 

 
 

 แท็บ Text: เป็นแท็บที่รวบรวมเครื่องมือส าหรับวาง และปรับแต่งตัวอักษรบนหน้าเว็บ 
 

 
 

 แท็บ Favorites: ใช้ส าหรับเพ่ิมเครื่องมือที่เรียกใช้งานบ่อยๆ โดยเพิ่มจากกลุ่มเครื่องมืออ่ืนๆ ได้โดยคลิก
เม้าส์ขวาบน Insert bar แล้วเลือก Customize Favorites (ตัวอย่างด้านล่างเป็นการดึงเครื่องที่ใช้งานบ่อยๆ คือ 
ตาราง รูปภาพ และ Rollover Image) 

 

 
 

 
 3. หน้าต่างการท างาน (Document Window) เป็นบริเวณท่ีใช้ในการออกแบบและสร้างเว็บเพจ 
ตามต้องการ ซึ่งสามารถแทรกข้อความ รูปภาพ และวัตถุต่าง ๆ ลงไปได้เลย ใน Dreamweaver สารมารถเลือก
มุมมองการท างานได้ 3 รูปแบบ ให้เราเลือกใช้ได้ตามความถนัดของเราโดยการคลิกไอคอนที่อยู่ในทูลบาร์ ดังนี้ 
 

Show Code View 

คลิกท่ี  จะปรากฏมุมมองแสดงโค้ด HTML หรือสครปิต์ต่าง ๆ ของหน้าเว็บเพจที่เราก าลัง
ท างานอยู่ ซึ่งเหมาะส าหรับผู้สร้างเว็บไซต์ที่สามารถเขียนโค้ด HTML หรือสคริปต์ต่าง ๆ ได ้
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คลิก Split 

 
 

 
 
 

Show Code and Design View 
คลิกท่ี  จะแสดงทั้งโค้ดพร้อมทั้งหน้าเว็บเพจที่เราก าลังท างานอยู่ เหมาะส าหรับผู้ใช้ที่ต้องการ 

ดูการแสดงผลโค้ดของหน้าเว็บเพจที่ใช้ในการออกแบบ 
  

          
 
 
 
 
 
 
 
 
 
 

Show Design View 

คลิก Code 
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คลิกที่  ส าหรับแสดงหน้าจอออกแบบเว็บเพจที่ไม่มีการแสดงโค้ดต่างๆ เหมาะส าหรับ 
ผู้ที่สร้างเว็บไซต์ที่ไม่รู้เกี่ยวกับการสร้างเว็บไซต์ด้วยภาษา HTML หรือสคริปต์ต่าง ๆ เพราะสามารถจัด
องค์ประกอบของภาพและข้อความบนหน้าเว็บนี้ได้อย่างง่าย ๆ 
 
 

 

 

 

 

 

 

 

 

 
 4. แถบสถานะ (Status bar) 

       แถบสถานะของ Dreamweaver จะแสดงข้อมูลเพ่ิมเติมเกี่ยวกับงานที่เราก าลังท า โดยมีส่วนประกอบ
ต่าง ๆ ดังนี้ 

 

 

 

 

 

 * ส่วนไว้เลือกแท็ก HTML (Tag Selector) : จะแสดงแท็ก HTML ของต าแหน่งที่เราคลิกเลือกบนหน้า
เว็บ เช่น เราคลิกเลือกตาราง ก็จะแสดงแท็ก <tabel> ซึ่งจะมีประโยชน์มากในการเลือกจุดแก้ไข เพราะสามารถ
เลือกจุกหรือแท็กท่ีต้องการได้อย่างแม่นย า 
 * ขนาดของหน้าจอออกแบบเว็บเพจ (Window Size) : จะแสดงขนาดของหน้าต่างออกแบบเว็บเพจ 

ขนาดของหน้าต่างออกแบบ
เว็บเพจ (Window Size) 

เครื่องมือปรับการแสดงผล
หน้าเว็บขณะออกแบบ 

ขนาดหน้าเว็บและ
เวลาที่ใช้ในการโหลด 

ส่วนไว้เลือกแท็ก HTML 
(Tag Selector) 

คลิก Design 
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 * เครื่องมือปรับการแสดงผลหน้าเว็บขณะออกแบบ : Zoom Tool  ใช้ส าหรับย่อขยายหน้าเว็บให้เห็น
รายละเอียดชัดขึ้น หรือใช้ Hand Tool  เลื่อนดูหน้าเว็บในส่วนที่มองไม่เห็น 
 * ขนาดของหน้าเว็บและเวลาที่ใช้ในการโหลด : จะแสดงเวลา (โดยประมาณ) ที่ใช้ในการโหลดหน้าเว็บ
เพจที่เราสร้าง โดยถ้าหน้าที่เราสร้างมีขนาดใหญ่เพราะมีข้อความ และรูปภาพจ านวนมาก ก็จะท าให้ต้องใช้เวลา
โหลดนาน นอกจากนั้นความเร็วในการโหลดหน้าเว็บขึ้นอยู่กับความเร็วในการโอนย้ายข้อมูลของผู้ใช้ที่เชื่อมต่อกับ
เครือข่ายอินเทอร์เน็ตด้วย โดยเริ่มแรก Dreamweaver จะแสดงเวลานี้โดยอ้างอิงกับโมด็มความเร็ว 60 k  
(เราสามารถเปลี่ยนค่านี้ได้ในบทการปรับแต่งค่า Dreamweaver) 
 

5. Properties Inspector ใช้ในการก าหนดค่าคุณสมบัติของหน้าเว็บเพจและในส่วนของวัตถุต่าง ๆ  
ซึ่งจะมีรายละเอียดแสดงขึ้นมา เมื่อมีการคลิกเลือกวัตถุนั้น ๆ 
     เมื่อใดที่เราคลิกเลือกภาพ หรือองค์ประกอบต่างๆบนหน้าเว็บ จะปรากฏ Property Inspector  
ที่แสดงค่าต่าง ๆ ของภาพให้เราปรับแต่งคุณสมบัติที่เกี่ยวข้องกับองค์ประกอบนั้นได้ ดังตัวอย่างเมื่อเราคลิกเลือก 
ที่ภาพ Property Inspector ก็จะแสดงคุณสมบัติต่างๆของภาพให้เราปรับแต่งได้ ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 

6. พาเนล (Panel) เป็นหน้าต่างหรือชุดค าสั่งพิเศษท่ีใช้งานเฉพาะด้าน เช่น ฐานข้อมูล ไฟล์งานต่างๆ 
สร้างการเชื่อมโยง รวมถึงเรื่องการอัพโหลดไฟล์งานขึ้นเซิร์ฟเวอร์ 
    ในโปรแกรม Dreamweaver มีหน้าต่างพาเนลต่าง ๆ ที่ช่วยเพิ่มความสามารถในการจัดการ และ
ออกแบบหน้าเว็บของเราได้ ซึ่งแต่ละพาเนลจะมีความสามารถในการจัดหน้าเว็บได้ไม่เหมือนกัน เราสามารถเรียก
เปิดพาเนลได้จากเมนูค าสั่ง Window > และเลือกพาเนลที่ต้องการดังนี้ 
 
 
 
 
 
 

Property Inspector  
แสดงรายละเอียด

ต่างๆ 

คลิกภาพ 
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พาเนล CSS 
 พาเนล CSS เป็นพาเนลที่ใช้ในการก าหนดรูปแบบการแสดง
หน้าเว็บ พาเนลนี้ประกอบไปด้วยแท็บ CSS Styles และแท็บ 
AP Elements 
 
 
 

พาเนล Application 
 พาเนล Application เป็นพาเนลที่เก่ียวกับการ
เชื่อมโยงเว็บไซต์ของเรากับฐานข้อมูลบนเครื่องเซิร์ฟเวอร์ โดย
พาเนลประกอบไปด้วยแท็บ Database, แท็บ Bindings, แท็บ 
Sever Behaviors และแท็บ Components 
 
 
 

เลือกเมนูค าสั่ง Window > 
เลือกพาเนลที่ต้องการ 

กลุ่มหน้าต่างพาเนลที่เรา
เลือกเปิดขึ้นมาใช้งาน 
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 พาเนล  Tag  Inspector 
 พาเนล Tag จะรวบรวมการใช้งานแท็กค าสั่งของ CSS 
(Cascade Style Sheet) ทั้งหมด ซึ่งในพาเนลนี้จะมีส่วนประกอบ
ทั้งหมด 2 แท็บ คือ แท็บ Attributes และแท็บ Behaviors 
 
 
 
 
 
 
 
 

 
พาเนล Files 
พาเนล Files เป็นพาเนลที่บอกว่าภายในเว็ปไซต์ของเรา

มีเว็บเพจ และโฟลเดอร์อะไรเก็บอยู่บ้าง โดยจะประกอบด้วยแท็บ 
Fikes, แท็บ Assets และแท็บ Snippets ที่อ านวยความสะดวก
ให้กับคนที่สร้างเว็บเพจในการแก้ไขโค้ด HTML และการแทรก
ภาษาสคริปต์ต่าง ๆ  
 
 

     
หากไม่จ าเป็นต้องปรับค่าจากพาเนล เราสามารถพับเก็บกรอบหน้าต่างพาเนล เพื่อเพ่ิมพ้ืนที่ในการตกแต่ง

เว็บเพจได้สะดวกข้ึน และเมื่อต้องการท างานก าหนดค่าในพาเนล ให้เปิดหน้าต่างกลับมาดังเดิมได้ ดังนี้ 
 
 

 
 
 
 
 

 
 

การพับเก็บกรอบหน้าต่างพาเนล 

1. คลิกเพื่อเก็บกรอบหน้าต่างพาเนล 
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 หากต้องการน าหน้าต่างพาเนลมาอยู่ใกล้พ้ืนที่การท างานในเว็บเพจ ก็สามารถดึงพาเนลออกมาจาก 

กรอบหน้าต่างได้ และเมื่อใช้งานเสร็จแล้วก็ดึงไปเก็บท่ีเดิม เพื่อไม่ให้เกะกะในพ้ืนที่ท างาน ดังนี้ 
 

      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ย้ายหน้าต่างพาเนลเข้า – ออก 

2. คลิกเพื่อแสดงกรอบหนา้ต่างพาเนล 
 

1. ลากเมาส์ที่แถบพาเนล
ไปวางต าแหน่งที่ต้องการ
จะใช้งาน 
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 ในหน้าเว็บเพจอาจประกอบด้วยองค์ประกอบหลายแบบหลายชนิด เช่น เนื้อความ , รูปภาพ , 
ภาพเคลื่อนไหว  และเสียงประกอบ เป็นต้น  องค์ประกอบเหล่านี้ เราเรียกว่า ออบเจ็ค (Object)  ดังตัวอย่าง
ด้านล่าง   
 
 
 
 
 
 
 
 
 
 

 
 
 
 
ในโปรแกรม Dreamweaver CS5นี้ เราสามารถสร้างและใส่ออบเจ็คชนิดต่างๆ ได้อย่างง่ายดาย  

ซึ่งจะอธิบายการใช้งานออบเจ็คแต่ละชนิดต่อไป 
 

องค์ประกอบของหน้าเว็บเพจ 

2. ลากเมาส์ที่แถบพาเนล 
จากนั้นปล่อยเมาส์ใน
ต าแหน่งท่ีปรากฏแถบสีทึบ 
เลื่อนพาเนลเข้ามาเก็บใน
กรอบหน้าต่างพาเนล 

รูปภาพ 

จุดเช่ือมโยง ข้อความ 
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ในการสร้างเว็บไซต์ด้วยโปรแกรม Dreamweaver เราจะเริ่มจากการก าหนดโครงร่างของเว็บ และ 

สร้างโฟลเดอร์และไฟล์ต่างๆ ที่ประกอบกันเป็นเว็บไซต์ของราก่อน ดังนี้ 
 
ก าหนดโครงร่างของเว็บ 

 ก่อนที่เราจะสร้างเว็บไซต์ขึ้นมา ขอแนะน าให้เริ่มออกแบบโครงร่างคร่าวๆของเว็บไซต์นั้นก่อน  
เพ่ือไม่ก่อให้เกิดความสับสนที่อาจตามมาในภายหลัง โดยเว็บไซต์ที่ประกอบด้วยเว็บเพจหลายหน้า จะนิยมจัดเก็บ
ไฟล์เว็บเพจไว้ในโฟลเดอร์แยกตามหัวข้อต่างๆ 

 ดังตัวอย่าง ถ้าเราต้องการจัดท าเว็บไซต์ขายเครื่องประดับ ก็อาจสร้างโฟลเดอร์ชื่อ “jewelry”  
เป็นโฟลเดอร์ที่รวมเว็บเพจ และไฟล์ต่างๆ ที่ใช้ไว้ทั้งหมด โดยในโฟลเดอร์นี้จะประกอบด้วยหลายโฟลเดอร์ย่อย
ส าหรับแยกเก็บไฟล์ต่างๆ ที่ประกอบกันเป็นเว็บไซต์ เช่น โฟลเดอร์ ชื่อ “home” “new” “catalog” “about” 
“contact” และจะเก็บไฟล์ .html ที่ใช้ ส่วนโฟลเดอร์ “images” จะเก็บไฟล์รูปภาพและมัลติมีเดียที่ใช้ 
ในเว็บไซต์ 
 

     
 เราจะเริ่มต้นโดยการก าหนดเว็บไซต์ใหม่ในโปรแกรม Dreamweaver โดยมี 2 วิธีที่ท าได้ วิธีแรกจะใช้ 

วิซาร์ดช่วย และวิธีที่สองเราจะก าหนดค่าต่างๆ เอง 
 วิธีที่ 1 สร้างเว็บไซต์แบบใช้วิซาร์ด  
 โดย Dreamweaver จะให้เราก าหนดเพียงข้อมูลพื้นฐานเกี่ยวกับการสร้างเว็บไซต์ใหม่ เช่น ต้องการสร้าง
เว็บไซต์กับเซิร์ฟเวอร์แบบไหน, ต้องการสร้างเว็บไซต์คนเดียว หรือท างานร่วมกันเป็นทีม เป็นต้น จากนั้น 
Dreamweaver จะช่วยก าหนดรายละเอียดเพ่ิมเติมให้ทั้งหมด นับเป็นวิธีที่สะดวกและรวดเร็วดังนี้ 
 
 
 
 
 
 
 
 
 
 
 
 

1. เลือกค าสั่ง Site > 
Manage Sites เพื่อ
เข้าสู่การสรา้งเว็บไซต์
ของเรา 

การสร้างเว็บไซต์

เร่ิมต้นสร้างเว็บไซต์ 
 

ก าหนดเว็บไซต์ใหม่ใน Dreamweaver 
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2. คลิกปุ่ม New แล้วเลือกค าสั่ง Site 
เพื่อสร้างเว็บไซต์ใหม ่

3.  ตั้งช่ือไซต์ 
    Site Name………………………. 
    ก าหนดพื้นที่จัดเก็บข้อมูล 
    Local Site Folder……………… 
 

4. โปรแกรมจะแสดงรายการของ   
Local Site  ที่เราก าหนดค่าไว้  จากน้ัน
คลิกที่ปุ่ม Done  เพื่อเข้าไปสร้างเว็บเพจ
ต่อไป 
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 ในกรณีที่ต้องการสร้างโฟลเดอร์ย่อยใต้โฟลเดอร์ที่เก็บเว็บไซต์ของเรา เพ่ือแยกเก็บข้อมูล และหน้าเว็บ 
ให้เป็นหมวดหมู่ ให้เราคลิกเมาส์ปุ่มขวาที่โฟลเดอร์ Site แล้วเลือก New Folder จะปรากฏไฟล์ใหม่ในรายการ  
ให้เราตั้งชื่อโฟลเดอร์ใหม่นี้แล้วกดปุ่ม <Enter> ดังนี้ 
 

         
 
 
 
 
 
 
               
 
 
 
เปลี่ยนชื่อไฟล์และโฟลเดอร์ 
 การเปลี่ยนชื่อไฟล์ และโฟลเดอร์ที่อยู่ภายในเว็บไซต์ของเราจะช่วยสื่อความหมายให้ตรงกับเนื้อหาโดยให้
เราคลิกที่ไฟล์ หรือโฟลเดอร์ที่ต้องการจะเปลี่ยนชื่อ คลิกซ้ าอีกครั้ง แล้วพิมพ์ชื่อไฟล์/โฟลเดอร์ใหม่ จากนั้นกดปุ่ม 
<Enter>  
        

1. คลิกเมาส์ปุ่มขวาท่ีโฟลเดอร์ Site แล้วเลือก New Folder 2. ตั้งช่ือโฟลเดอร์ใหม่แล้วกดปุ่ม <Enter> 

สร้างโฟลเดอร์ใหม่ในเว็บไซต์ 
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1. เลือกค าสั่ง 
File > New…  

2. คลิกรายการ 
Blank Page > 
HTML แล้วคลิกปุม่ 
Create  

3. แสดงหน้าเว็บใหม ่ 

การสร้างหน้าเว็บเพจใหม่
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 นอกจากการสร้างหน้าเว็บเปล่า ที่หน้าต่าง New Document จะแสดงหน้าเว็บแต่ละแบบให้เราเลือกใช้
ได้เลย ดังนี้ 

Blank Page สร้างหน้าเว็บเปล่า โดยสามารถก าหนดชนิดของหน้าเว็บที่เราจะใช้งานได้ เช่น หน้าเว็บ 
HTML, เทมเพลต, ไลบรารี่, XSLT, ActionScript, CSS, JavaScript และ XML หรือ
หน้าเว็บแบบไดนามิกที่สนับสนุนการท างานด้วยภาษาที่ใช้บนเว็บเซิร์ฟเวอร์ เช่น ASP, 
ColdFusion, JSP และ PHP เป็นต้น 

Blank Template สร้างหน้าเทมเพลต เพ่ือใช้เป็นต้นแบบในการสร้างหน้าเว็บ 

Page from Template สร้างหน้าเว็บโดยใช้ต้นแบบ 

Page from Sample สร้างหน้าเว็บจากต้นแบบที่ Dreamweaver มีให้ 

Other สร้างหน้าเว็บแบบอื่นๆ เช่น หน้าเว็บที่มีการใช้ภาษา C#, VBScript หรอื เท็กซ์ไฟล์ 
เป็นต้น 

 
 
 
 
 
 

หน้าเว็บรูปแบบต่างๆ ท่ีน ามาใช้ได้ 
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 การก าหนดรายละเอียดของหน้าเว็บ โดยเลือกค าสั่ง Modify > Page Properties จะพบกับหน้าต่าง 
Page Properties ดังนี้ 

 

 

  

 

 

 

 

หน้าต่าง Page Properties จะแบ่งรายละเอียดต่างๆของหน้าเว็บที่ปรับแต่งได้ออกเป็น 5 หมวด ดังนี้ 
หมวด Appearance ก าหนดหน้าตาของส่วนประกอบต่างๆ บนหน้าเว็บ 

 Page font  ก าหนดรูปแบบของตัวอักษรที่ใช้ในเว็บเพจ 
Size  ก าหนดขนาดของรูปแบบตัวอักษรที่ใช้ 
Text color  ก าหนดสีให้กับตัวอักษร 
Background color  ก าหนดสีที่ต้องการให้เป็นพ้ืนหลังของหน้าเว็บ 
Background Image ก าหนดภาพที่ใช้เป็นฉากหลังของหน้าเว็บ 
Repeat  ก าหนดการแสดงซ้ าของภาพพ้ืนหลัง 
Left Margin ก าหนดระยะขอบซ้ายของหน้าเว็บ 
Right  Margin ก าหนดระยะขอบขวาของหน้าเว็บ 
Top Margin ก าหนดระยะขอบบนของหน้าเว็บ 
Bottom  Margin ก าหนดระยะขอบล่างของหน้าเว็บ 

 

 

 

 

 

รายละเอียดหน้าเว็บ 



 
 

32 
 

 

 
หมวด Links ก าหนดแสดงลิงค์บนหน้าเว็บ 

 
Link font   ก าหนดรูปแบบของตัวอักษรของลิงค์ 
Size  ก าหนดขนาดของรูปแบบตัวอักษรของลิงค์ 
Links color ก าหนดสีของลิงค์ 
Rollover links ก าหนดสีของลิงค์เมื่อใช้เมาส์ไปชี้ 
Visited links ก าหนดสีของลิงค์เมื่อถูกคลิกไปแล้ว 
Active links ก าหนดสีของลิงค์เมื่อก าลังถูกคลิก 
Underline style ก าหนดรูปแบบการขีดเส้นใต้ให้กับลิงค์ 

 

หมวด Headings ก าหนดคุณสมบัติหัวของเว็บเพจ 

 
Heading font ก าหนดรูปแบบของตัวอักษรให้หัวข้อที่แสดงบนหน้าเว็บ 
Heading  1-6 ก าหนดขนาดของรูปแบบตัวอักษรที่ใช้สร้างหัวข้อบนหน้าเว็บ 
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หมวด Title/Encoding ก าหนดชื่อให้ส่วนหัวเรื่องของเว็บเพจ และก าหนดชุดตัวอักษรที่ใช้ 

 

Title  ก าหนดส่วนชื่อหัวเรื่องให้เว็บเพจ 
Document type ก าหนดประเภทของเว็บเพจ 

     Encoding  ก าหนดรูปแบบภาษาของตัวอักษรที่ใช้ในเว็บเพจ ส าหรับการแปลงตัวอักษร เพื่อให้เป็น 
    ภาษามาตรฐานที่ต้องการ ถ้าเราต้องการใช้ภาษาไทยให้เลือกไทย (Windows) หรือ  
    Unicode (UTF-8)  

 

หมวด Tracing Image ก าหนดคุณสมบัติหัวของภาพที่จะใช้เป็นแบบในการสร้างหน้าเว็บเพจ 

 

Tracing Image  เลือกไฟล์ภาพที่จะใช้ 
  Image Transparency ก าหนดค่าความโปร่งใสของภาพ โดยภาพจะเป็นแบบสีจางๆ ด้านหลัง  

ช่วยให้เราเห็นต าแหน่งวางภาพ วางข้อความที่ถูกต้อง 
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 ขั้นตอนที่ 1 ก าหนดหัวเรื่องบนหน้าเว็บ 
 เราสามารถใส่หัวเรื่องบนหน้าเว็บ หรือท่ีนิยมเรียกว่าไตเติ้ล (Title) ได้ที่ช่อง Title บนแถบเครื่องมือ ดังนี้ 
 
 

 
 
  
 
 
 
 
 
 
 
 
 
 
ขั้นตอนที่ 2 แทรกภาพในหน้าเว็บเพจ 

 แทรกภาพลงหน้าเว็บเพจ มีวิธีการดังนี้ 

 
 
 
 
 
 
 
 
 
 
 

ในช่อง Title ใส่ช่ือหัวเรื่อง
ที่เราต้องการบนหนา้เว็บ
ของเรา  

1. เลือกต าแหน่งของภาพ
ที่ต้องการจะวางบนหน้า
เว็บแล้วเลือกเครื่องมือ 

 (image) แท็บ 
Common 

การเพิ่มเนื้อหาในหน้าเว็บ 
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 โปรแกรมจะแสดงคุณสมบัติของวัตถุรูปภาพให้เราสามารถปรับแต่งค่าต่าง ๆ ได้ทั้งหมด เช่นการปรับ
ขนาดรูปภาพ  การท า Map Images  การเชื่อมโยง  การก าหนดให้มีค าอธิบายรูปภาพ 

2. เลือกภาพที่ต้องการ 

3. คลิก  เพื่อตกลงเลือกภาพ  

4. เขียนค าอธิบายรูปภาพ 
และคลิก  

ผลลัพธ์ที่ได ้



 
 

36 
 

 

 ขั้นตอนที่ 3 ใส่ข้อความบนหน้าเว็บ 
 การใส่ข้อความบนหน้าเว็บคล้ายกับการพิมพ์เอกสารในโปรแกรม Word โดยให้เราคลิกบนพื้นที่ท างาน 
แล้วพิมพ์ข้อความบนหน้าเว็บได้เลย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 การกดปุ่ม <Enter> จะเป็นการขึ้นย่อหน้าใหม่ และข้อความในแต่ละย่อหน้าจะถูกจัดให้เต็มหน้าต่าง 
 ในกรณีที่เราต้องการข้ึนบรรทัดใหม่ในย่อหน้าเดิม ให้กด <Shift + Enter> แทน (หรือคลิกแท็บ Text 
และคลิกปุ่ม  ก็ได้)  
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 หลังจากท่ีเราสร้างเว็บเพจได้ตามต้องการแล้ว ให้ท าการบันทึกไฟล์เว็บเพจ โดยเลือกค าสั่ง File > Save 
เนื่องจากเรายังไม่เคยบันทึกไฟล์นี้มาก่อนโปรแกรม Dreamweaver จะให้เราระบุชื่อไฟล์ใหม่ด้วย เช่น 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 จากนั้นเมื่อใดที่เราท าการแก้ไขหน้าเว็บ และต้องการบันทึกการเปลี่ยนแปลง ก็ให้เลือกค าสั่ง  File > 
Save เพ่ือบันทึกหน้าเว็บแทนที่ไฟล์เดิมที่บันทึกไว้ได้ แต่ถ้าต้องการบันทึกไฟล์นี้ไว้ที่ต าแหน่งใหม่ หรือบันทึกเป็น
ไฟล์ใหม่ ให้เลือกค าสั่ง File > Save As… และก าหนดต าแหน่งเก็บและชื่อไฟล์ได้ 

 

 

2. เลือกพื้นที่จัดเก็บไฟล ์  หากมีการก าหนด Local Site ไว้โปรแกรมจะแสดงโฟลเดอร์ที่ก าหนดไว้ให้ทันที 

3. ตั้งช่ือไฟล์  โดยตั้งช่ือเป็น
ภาษาอังกฤษห้ามเว้นวรรค และ
สัญลักษณ์ทางคณิตศาสตร ์

4. คลิกปุ่ม    
เพื่อบันทึกไฟล ์

1. เลือกค าสั่ง  
File > Save  

บันทึกไฟล์เว็บเพจที่สร้าง 
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  ในกรณีที่เราต้องการยกเลิกสิ่งที่เราได้กระท าไปแล้ว เราสามารถกระท าได้โดยเปิดใช้พาเนล History  
ซึ่งพาเนลนี้จะช่วยให้เราดู, ยกเลิก, หรือท าซ้ าการกระท าใด ๆ ที่ได้กระท าไปแล้ว 
 การเปิดใช้พาเนล   History   จะกระท าได้โดยเลือกเมนูค าสั่ง Windows เลือกค าสั่ง History 
 
 
 
 
 
 
 
 
 
 

 
 

     

 เมื่อเราบันทึกเว็บเพจที่เราสร้างเสร็จเรียบร้อยแล้ว ให้เปิดดูหน้าเว็บได้บราวเซอร์ โดยเลือกค าสั่ง  
File > Preview in Browser > ชื่อบราวเซอร์ที่ติดตั้งไว้ในเครื่อง (หรือกดคีย์ลัด <F12>)  

 

 

 

 

 

 

 

แถบเลื่อน 

ขั้นตอนการท างาน 

บันทึกข้ันตอนการท างาน 

คัดลอกขั้นตอนการท างาน ท าซ้ าข้ันตอนการท างาน 

   การแก้ไขข้อผิดพลาดด้วยพาเนล History 

การเปิดดูหน้าเว็บที่สร้างบนบราวเซอร์ 

1. เลือกค าสั่ง File > Preview 
in Browser > IExplorer  
หรือ กด <F12>  
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2. แสดงหน้า
เว็บที่เราสร้าง
บราวเซอร ์
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ค ำชี้แจง  ให้นักเรียนอ่านค าถามให้เข้าใจ และเขียนตอบค าถามในช่องว่างที่ก าหนดให้ ให้ถูกต้อง 
             คะแนน 10 คะแนน 
 
 1. จงอธิบายการสร้างเว็บเพจ  มีก่ีวิธี และแต่ละวิธีมีวิธีการสร้างอย่างไร (5 คะแนน) 
............................................................................................................................. .......................................................
.................................................................................................................................................. ..................................
................................................................................................. ...................................................................................
............................................................................................................................. .......................................................
............................................................................................................................. ....................................................... 
.................................................................... ................................................................................ ................................ 
 
 2. จงอธิบายส่วนประกอบใน WWW (World Wide Web) มาอย่างละเอียด (5 คะแนน) 
............................................................................................................................. .......................................................
............................................................................ ........................................................................................................
............................................................................................................................. .......................................................
............................................................................................................................. .......................................................
............................................................................................................................................................................. ....... 
............................................................................................................................. .......................................................  
............................................................................................................................. .......................................................
............................................................................ ........................................................................................................  
............................................................................................................................. .......................................................  
............................................................................................................................. .......................................................
.......................................................................................................................................................................... .......... 
........................................................................................................................ ............................................................  
  

กิจกรรมที่ 1 
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ค ำชี้แจง  ให้นักเรียนอ่านข้อความที่ก าหนดให้ และท าเครื่องหมาย หน้าข้อที่กล่าวถูกต้อง  
            และท าเครื่องหมาย   หน้าข้อที่กล่าวผิด ให้ถูกต้อง คะแนน 10 คะแนน 

 
     1.  HTML (Hypertext Markup Language) เป็นภาษาท่ีใช้ในการเขียนโปรแกรมภาษาหนึ่งของคอมพิวเตอร์ 

     2. Open a Recent Item เป็นการเปิดไฟล์งานที่เคยใช้งานแล้ว โดยจะมีรายชื่อไฟล์งานแสดงอยู่เรียงล าดับ 
         จากชื่อตัวอักษรของงาน เป็นต้นไป 

     3. ในการยกเลิกค าเลือกค าสั่ง  Edit  >  Undo 

     4. ในการเปิดใช้งานโปรแกรม คลิก Start  All Programs   Adobe Dreamweaver CS5  

     5. หน้าต่างการท างาน (Document Window) ใช้ส าหรบัเพิ่มเครื่องมือที่เรียกใช้งานบ่อยๆ  
         โดยเพิ่มจากกลุ่มเครื่องมืออื่นๆ 

     6. ในหน้าเว็บเพจอาจประกอบด้วยองค์ประกอบหลายองค์ประกอบซึ่งเรียกว่า ออบเจ็ค (Object)   

     7. Other สร้างหน้าเว็บแบบอื่นๆ เช่น หน้าเว็บที่มีการใช้ภาษา C#, VBScript หรือ เท็กซ์ไฟล์ 

     8. ในการสร้างเว็บไซต์ด้วยโปรแกรม Dreamweaver เราจะเริ่มจากการก าหนดโครงร่างของเว็บ 

     9. Page font คือการก าหนดหน้าของตัวอักษรที่ใช้ในเว็บเพจ 

     10. การเปิดใช้พาเนล   History   จะกระท าได้โดยเลือกเมนูค าสั่ง F1  

 
 
 
 
 
 
 

กิจกรรมที่ 2 
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แบบทดสอบหลังเรียน 
เรื่อง การใช้โปรแกรม Adobe Dreamweaver CS5  

เล่มท่ี 1 ความรู้พื้นฐานก่อนใช้งาน  Adobe  Dreamweaver CS5 

 
 
 
 

 
ค าชี้แจง  ให้นักเรียนเลือกค าตอบที่ถูกที่สุดเพียงค าตอบเดียวและท าเครื่องหมายกากบาท ( X )  
   ลงในกระดาษค าตอบ เวลา 10 นาที คะแนน 15 คะแนน 
 

ข้อ 1 ข้อมูลจากทุกมุมโลกที่ถูกโยงใยไปมาถึงกันได้ราวกับสิ่งใด 
  ก. เส้นขนมสายไหม  ข. ลูกโลก 
   ค. ใยแมงมุม   ง. สายรุ้ง 
 
ข้อ 2 ในก าหนดเว็บไซต์ใหม่ใน Dreamweaver มีก่ีวิธี 
 ก. 1 วิธ ี    ข. 2 วิธ ี 
 ค. 3 วิธ ี    ง. 4 วิธ ี  

ข้อ 3 ข้อใดมกีารเรียกใช้โปรแกรม  Adobe  Dreamweaver  CS5 ได้ถูกต้อง 
 ก. Start      Accessories         Adobe Dreamweaver CS5   
 ข. Start      ACD system         Adobe Dreamweaver CS5 
   ค. Start      Control Panel      Adobe Dreamweaver CS5    
        ง. Start      All Programs         Adobe Dreamweaver CS5  

ข้อ 4 ข้อใดไม่ใชส่่วนประกอบใน WWW 
   ก. Home Page   ข. Web Site 
  ค. Web face   ง. Web Browser 

ข้อ 5 ภาษาทางคอมพิวเตอร์ที่พัฒนาขึ้นใหม่ ในการใช้ Adobe Dreamweaver เรียกว่า ภาษาใดต่อไปนี้ 
 ก. HTML    ข. Visual basic 
 ค. Java    ง. PHP 

ข้อ 6 โปรแกรม Adobe Dreamweaver มีส่วนประกอบหลัก ๆ ดังต่อไปนี้ ยกเว้นข้อใด 
 ก. เมนูบาร์ (Menu bar)     ข. ชาเนล (Chanel) 
 ค. แท็บเครื่องมือ   ง. แถบสถานะ (Status bar) 

ข้อ 7 เนื้อความ , รูปภาพ และเสียง องค์ประกอบเหล่านี้ เราเรียกว่าอะไร  
 ก. Object   ข. Catalog 
 ค. Text    ง.  File 
 
ข้อ 8 WWW ย่อมาจากค าใดต่อไปนี้ 
 ก. Word While Web  ข. World Wide Web 
 ค. World Wi Web  ง. Word Why Web 
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ข้อ 9 หากต้องการเปิดดูหน้าเว็บที่สร้างไว้บนบราวเซอร์ด้วยวิธีลัด โดยกดปุ่มใด 
 ก. F1 
 ข. F2 
 ค. F10 
 ง. F12 

ข้อ 10 ข้อใดกล่าวเกี่ยวกับหน้าที่ Page from Sample ได้ถูกต้อง 
 ก.  สร้างหน้าเว็บโดยใช้ต้นแบบ ข. สร้างหน้าเทมเพลต เพ่ือใช้เป็นต้นแบบในการสร้างหน้าเว็บ 
 ค. สร้างหน้าเว็บแบบอื่นๆ  ง. สร้างหน้าเว็บจากต้นแบบที่ Dreamweaver มีให้ 
 

ข้อ 11 ในการใส่ข้อความบนหน้าเว็บคล้ายกับการพิมพ์เอกสารในโปรแกรมใด  
 ก. โปรแกรม Word  ข. โปรแกรม Excel 
 ค. โปรแกรม paint  ง. โปรแกรม bookmark 

ข้อ 12 หมวด Headings ท าหน้าที่เก่ียวกับสิ่งใด 
 ก. ก าหนดแสดงลิงค์บนหน้าเว็บ ข. ก าหนดหน้าตาของส่วนประกอบต่างๆ บนหน้าเว็บ 

 ค. ก าหนดคุณสมบัติหัวของเว็บเพจ ง. ก าหนดชื่อให้ส่วนหัวเรื่องของเว็บเพจ 

ข้อ 13 หน้าต่างการท างานใน Dreamweaver สารมารถเลือกมุมมองการท างานได้กี่รูปแบบ  
 ก. 2 รูปแบบ   ข. 3 รูปแบบ 
 ค. 4 รูปแบบ   ง.  5 รูปแบบ 

ข้อ 14 ข้อใดเป็นแท็บที่รวบรวมเครื่องมือส าหรับวาง และปรับแต่งตัวอักษรบนหน้าเว็บ 
 ก. Layout 
 ข. Text 
 ค. Spry 
 ง. Data 

ข้อ 15 แท็บ Layout เป็นแท็บที่ท าหน้าที่เกี่ยวกับสิ่งใด 
 ก. รวบรวมเครื่องมือที่ใช้ในการสร้างแบบฟอร์มสอบถาม     
 ข. รวบรวมเครื่องมือที่ช่วยในการจัดองค์ประกอบบนหน้าเวบ็ 
 ค. รวบรวมเครื่องมือส าหรับสร้างแอพพลิเคชั่นติดต่อกับฐานข้อมูล     
 ง. รวบรวมเครื่องมือที่ช่วยให้การสร้างฟอร์มได้รวดเร็วขึ้น 
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ข้อ ก ข ค ง ข้อ ก ข ค ง 
1     11     
2     12     
3     13     
4     14     
5     15     
6          
7          
8          
9          
10          

กระดาษค าตอบ 
แบบทดสอบหลังเรียน 
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กระทรวงศึกษาธิการ. คู่มือพัฒนาสื่อการเรียนรู้. กรุงเทพมหานคร : คุรุสภาลาดพร้าว, 2551. 
กระทรวงศึกษาธิการ. หลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน พุทธศักราช 2551. กรุงเทพมหานคร :  

โรงพิมพ์ชุมนุมสหกรณ์การเกษตรแห่งประเทศไทย, 2551. 
จรัส จรัสรงุเรืองชัย. ออกแบบและพัฒนาเว็บไซตดวย Dreamweaver CS5. กรุงเทพมหานคร :  
 บริษัท ซีเอ็ด ยูเคชั่น จํากัด (มหาชน),  2555. 
พันจันทร ธนวัฒนเสถียร. Adobe Dreamweaver CS5 ฉบับผูเริ่มตน. กรุงเทพมหานคร :  
 บริษัท ซีเอ็ด ยูเคชั่น จํากัด (มหาชน),  2554. 
สํานักวิชาการและมาตรฐานการศึกษา. ตัวชี้วัดและสาระการเรียนรู้กลุ่มสาระการเรียนรู้การงาน 
  อาชีพและเทคโนโลยี ตามหลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน พุทธศักราช 2551.   
  กรุงเทพมหานคร : โรงพิมพ์ชุมนุมสหกรณ์การเกษตรแห่งประเทศไทย, 2551. 
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ค ำชี้แจง  ให้นักเรียนอ่านค าถามให้เข้าใจ และเขียนตอบค าถามในช่องว่างที่ก าหนดให้ ให้ถูกต้อง 
             คะแนน 10 คะแนน 
 

ค ำชี้แจง  ให้นักเรียนอ่านค าถามให้เข้าใจ และเขียนตอบค าถามในช่องว่างที่ก าหนดให้ ให้ถูกต้อง 
             คะแนน 10 คะแนน 
 
 1. จงอธิบายการสร้างเว็บเพจ  มีก่ีวิธี และแต่ละวิธีมีวิธีการสร้างอย่างไร (5 คะแนน) 
............................................................................................................................. .......................................................
.................................................................................................................................................. ..................................
.......................................................ขึ้นอยู่กับดุลยพินิจของครูผู้สอน.......................................................................... 
............................................................................................................................. .......................................................
........................................................................................................................................ ........................................... 
....................................................................................... .............................................................................................  
 
 2. จงอธิบายส่วนประกอบใน WWW (World Wide Web) มาอย่างละเอียด (5 คะแนน) 

ตอบ     1. Home Page เว็บเพจหน้าแรกสุดของข้อมูลแต่ละเรื่อง ซึ่งก็เปรียบเสมือนหน้าปกของหนังสือนั่นเอง 
ส่วนของโฮมเพจนี้จะเป็นส่วนที่บอกให้ทราบว่าข้อมูลนี้เป็นข้อมูลเรื่องใด พร้อมกับมีสารบัญในการเลือกไปยัง
หัวข้อต่างๆ ในเรื่องนั้นๆ ด้วย 
 2. Web Site เป็นเครื่องมือที่ใช้ในการจัดเก็บเว็บเพจแต่ละองค์กรที่จะน าเสนอข้อมูลของตนในรูปของ
เว็บนี้มักจะมีเว็บไซต์เป็นของตนเอง และมักใช้ชื่อองค์กรเป็นชื่อเว็บไซต์เพ่ือให้ผู้สนใจสามารถจดจ าได้ง่าย 
 3. Web Page เอกสารข้อมูลในแต่ละหน้าซึ่งถูกเขียนขึ้นด้วยภาษา HTML ข้อมูลที่แสดงในเว็บเพจแต่ละ
หน้านี้อาจประกอบด้วยข้อความ , ภาพ และเสียง จึงเป็นข้อมูลแบบสื่อประสม หรือ มัลติมีเดีย 
 4. เว็บบราวเซอร์ (Web Browser) ปัจจุบันเป็นที่นิยมของผู้ใช้งาน Internet เป็นอย่างมาก ความนิยม
ของผู้ใช้ทั่วโลกใกล้เคียงกันกับ Google Chrome เพราะมีความปลอดภัยสูง การเปิดหน้าเว็บเพจท าได้อย่าง
รวดเร็ว มีโปรแกรมเสริม  
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ค ำชี่แจง  ให้นักเรียนอ่านข้อความที่ก าหนดให้ และท าเครื่องหมาย หน้าข้อที่กล่าวถูกต้อง  
            และท าเครื่องหมาย   หน้าข้อที่กล่าวผิด ให้ถูกต้อง คะแนน 10 คะแนน 
 
        1.  HTML (Hypertext Markup Language) เป็นภาษาท่ีใช้ในการเขียนโปรแกรมภาษาหนึ่ง 
       ของคอมพิวเตอร์ 

         2. Open a Recent Item เป็นการเปิดไฟล์งานที่เคยใช้งานแล้ว โดยจะมีรายชื่อไฟล์งานแสดง 
       อยู่เรียงล าดับจากชื่อตัวอักษรของงาน เป็นต้นไป 

        3. ในการยกเลิกค าเลือกค าสั่ง  Edit  >  Undo 

        4. ในการเปิดใช้งานโปรแกรม คลิก Start  All Programs   Adobe Dreamweaver CS5  

         5. หน้าต่างการท างาน (Document Window) ใช้ส าหรับเพ่ิมเครื่องมือที่เรียกใช้งานบ่อยๆ  
       โดยเพิ่มจากกลุ่มเครื่องมืออ่ืนๆ 

        6. ในหน้าเว็บเพจอาจประกอบด้วยองค์ประกอบหลายองค์ประกอบซึ่งเรียกว่า ออบเจ็ค (Object)   

         7. Other สร้างหน้าเว็บแบบอื่นๆ เช่น หน้าเว็บที่มีการใช้ภาษา C#, VBScript หรือ เท็กซ์ไฟล์ 

        8. ในการสร้างเว็บไซต์ด้วยโปรแกรม Dreamweaver เราจะเริ่มจากการก าหนดโครงร่างของเว็บ 

         9. Page font คือการก าหนดหน้าของตัวอักษรที่ใช้ในเว็บเพจ 

         10. การเปิดใช้พาเนล   History   จะกระท าได้โดยเลือกเมนูค าสั่ง F1  

 
 

 
 
 
 
 
 
 
 
 

  กิจกรรมที่ 2 
เรื่อง กำรใช้โปรแกรม Adobe Dreamweaver CS5  

เล่มท่ี 1 ควำมรู้พื้นฐำนก่อนใช้งำน  Adobe  Dreamweaver CS5 
 



49 

 
  
 
 
 
 
 

 
 

      
     
      

 
      
     

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 

  แบบทดสอบก่อนเรียน 
เรื่อง  กำรใช้โปรแกรม Adobe Dreamweaver CS5  

เล่มท่ี 1 ควำมรู้พื้นฐำนก่อนใช้งำน  Adobe  Dreamweaver CS5 

1.ข 2.ก 3.ค 4.ค 5.ง 

6.ข 7.ก 8.ข 9.ง 10.ค 

11.ก 12.ง 13.ข 14.ข 15.ข 



50 

 
 

  
 
 
 
 
 

 
 

      
     
      

 
      
     

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 

 
 

 

  แบบทดสอบหลังเรียน 
เรื่อง  กำรใช้โปรแกรม Adobe Dreamweaver CS5  

เล่มท่ี 1 ควำมรู้พื้นฐำนก่อนใช้งำน  Adobe  Dreamweaver CS5 

1.ค 2.ข 3.ง 4.ค 5.ก 

6.ข 7.ก 8.ข 9.ง 10.ง 
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